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Dose Calculations Screen

The Dose Calculations screen (Figure 5.1) opens when you click the "Dose
Calculations” button (on the Main Screen).

alculalwns

Figure 5.1. The Dose Calculations screen.
The screen is divided into these functional parts:

Menu Bar.

Intake sub-panel.

Calculation sub-panel.
Calculation Progress Indicator.
Dose Results windows.

Dose Calculations Menus 00
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Figure 5.2. Dose Calculations Menus.

These are:

e the File menu - to Save all parameter values to a Parameter File;

e the Tools menu - to open the "Equivalent Doses to Selected Organ Calculated in
Each Calendar Year" window;

e the Advanced menu — to open “Advanced Dosimetry Options”;

e the Help menu - giving access to the full range of Help facilities.

Dose Calculation Tools 00

File | Toolz Advanced Help
Organ Doses received each ye:

Save Cluick Save

Figure 5.3. Tool to open "Equivalent Doses to Selected Organ Calculated in Each
Calendar Year" window.

Clicking on "Organ Doses received in each year" opens the "Equivalent Doses to
Selected Organ Calculated in Each Calendar Year" window (Figure 5.4). This option
(developed for IMBA Expert™ OCAS-Edition) is provided in IMBA Professional Plus, Add-On
9, Dose Calculation For Causation. It will enable you to calculate equivalent doses received
by a specified organ over a prescribed time period, as used to calculate cancer causation
probability - see the OCAS-IREP web page (http://www.cdc.gov/niosh/ocas/ocasirep.html#irep).
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Figure 5.4. Window used to calculated equivalent doses received by a specified organ in
each year.

Advanced Dose Calculations Menu

ﬂ!‘} Doze Calculations
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Save

Cluick Save

Figure 5.5. Tool to open the "Advanced Dosimetry Options" window.

The "Advanced Dosimetry Options" window gives the following options:

Exclude nuclear recoil energy from the SEEs for alpha emissions.

Use Bayesian Analysis in the bioassay fitting procedure.
Use measurements of Am-241 activity to evaluate Pu-241 content.
Miscellaneous special functions - reserved for the future.
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Nuclear Recoil Energy in SEE 00
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{Dus&‘f Fittirg T Bioazzay T Pz ]

Muclear Recoil Energy
& |nclude
" Exclude

[Doze Calculation Optimization

The doze calculation for iz already optimized for bath
zpeed and accuracy

Ok LCancel |

Figure 5.6. Advanced Dosimetry Options window showing option to Exclude nuclear
recoil energy from the SEEs for alpha emissions.

In the basic software version (IMBA Professional Lite-Edition), nuclear recoil energy is (by
default) included in the SEEs for alpha emissions.

Special Fitting Procedure 00
Select to apply the "| east Squares", "Maximum Likelihood" (the default), or "Bayesian" fitting

method (Figure 5.7) in the calculation of intake(s). This option is also available from
the Bioassay Calculations screen (Advanced Menu ).
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Figure 5.7. "Fitting" Options window.

Special Bioassay Procedure 00

This will enable measurements of 241Am, e.qg., in the lungs, to be used as an indicator

of 241 Pu activity (Figure 5.8), by automatically accounting for 241 Am in-growth over time.
The option is made available automatically when the Indicator Nuclide is defined

as 241Am, AND 241Pu is included in the list of Associated Radionuclides. See Case Of Am-

241 In-growth as an example.

E@Advanced Dozimetry Options

Thesze options should be used with extreme care

Dose T Fitting TBiuassayT Mizc ]
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Cancel |

Figure 5.8. Future Special Bioassay feature.
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Figure 5.9. "Miscellaneous” Option - Use of "Mass" as the Unit of Intake.

When checked, this option allows Intakes to be specified in terms of Mass rather
than Activity, with the associated Specific Activity. If you don't define the specific
activity, you will be prompted to do this (figure 5.10).

Tn oeder bo enable unis of mg {on Bhe main screend you must speciy 2 vakes for the Spedfic Activiey

[

Figure 5.10. Prompt to define Specific Activity in order to use Mass as the Unit of
Intake.

Checking this option automatically highlights and enables the "mg" Unit of Intake in the
"Units" panel of the Main Screen (Figure 5.11).

i~ Intake -
™~ Bg T dpm

" pCi o+ mg

i Dioze
v S £ rem

" mSy 7 mrem

Figure 5.11. "mg" Unit of Intake enabled.

For an example of the use of "Mass" as the Unit of Intake, see Example Bioassay Cases -
“Case of Uranium Isotopic Mixture”.

Intake Sub-Panel - Dose Calculations 00
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Figure 5.12. Intake sub-panel.

The Intake sub-panel shown in Figure 5.12 is displaying the calculated amounts of three

intakes (IR1, IR2 and IR3). These values are the result of the
Intakes using the Miller et al. (1999) data. You can also enter hypothetical values of intake,
or values from other sources, directly in the Intake dialog boxes.

Dose Calculations Sub-Panel 00
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Figure 5.13. Dose Calculation sub-panel at start-up.

Figure 5.13 shows the Dose Calculation sub-panel as it appears for a New case

(blank Parameter File). Note the red flags above the "WR" and "WT" tabs, signifying that
neither the Radiation Weighting Factors nor the Tissue Weighting Factors to be used in
the dose calculation have yet been defined. Also, no Indicator Nuclide has yet been
defined - signified by the absence of a named radionuclide in the " (1) Dose from Indicator
Nuclide" label.

Dose from Associated Radionuclides 00

Returning to the Miller et al. (1999) example case, let's assume that each intake of 238Pu was
associated with two additional radionuclides, 239Pu and 241Am. Let's hypothesize that

the 239 Pu activity concentration in the inhaled material was 15% of the indicator 238 Pu
value, and the 241 Am activity concentration 5%. These values are set up in the Associated
Radionuclides sub-panel of the Main Screen, as shown in Figure 5.14.
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Figure 5.14. Example of two Associated Radionuclides, with 238Pu as the Indicator
Nuclide.

For this example, the Dose Calculation sub-panel will appear as shown in Figure 5.15.
Note that a second checkbox is now activated - for " (2) Dose from Associated
Radionuclides".

CALCULATION
_|>g

Eal-::ulatiunsl Wh ] W T ]

— Select
[11 Dioze from Indicator Muclide: Pu-238 v
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LCalculate | ||:|_|:||:|E +00

Figure 5.15. Dose Calculation sub-panel for case with Associated Radionuclides.

Defining the Radiation Weighting ©0

file://C:\Documents%?20and%20Settings\Administrator\Local%20Settings\Temp\~hh...  15/10/2005



Dose Calculations Screen Page 10 of 15
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that will be uszed in the calculation of equivalent doze.
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Clear
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ICRFP Defaults

Figure 5.16. Selection of ICRP-recommended Radiation Weighting Factors.

Click the "WR" tab and click the "ICRP Defaults" button to load the ICRP-recommended
values for the Radiation Weighting Factors. You can also define your own (User Defined)
value for Alpha, Beta and/or Gamma radiation.

Selecting the Tissue Weighting 00
Factors
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CALCULATION
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(Edit Tizzue Weighting

ICRP 68

Figure 5.17. Selection of ICRP60/68 Tissue Weighting Factors and Remainder Tissue
Rules.

Click the "WT" tab to select or edit the Tissue Weighting Factors and Remainder Tissue
Rules to be used for the calculation of Effective Dose (Figure 5.17). In this example, the
values recommended in ICRP 60/68 have been selected. Click the "Edit Tissue Weighting
Factors" button to view these selected (and loaded) values (Figure 5.18).
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Figure 5.18. The Tissue Weighting Factors window.

In this window, you can also opt to use the values of Tissue Weighting
Factor and Remainder Tissue Rules required in 10 CFR 835 (for use in the U.S.), or those
recommended in ICRP26/30, on which the 10 CFR 835 values are based.

Dose Calculation Progress Indicator 00

To calculate (and display) the resulting doses, check the required calculation(s), and click the
"calculate" button. If you have forgotten to specify the Biokinetic Model for

the Indicator Nuclide, you will see the Warning Notice shown in Figure 5.19. Once you
have selected the Biokinetic Model, the dose calculation will proceed automatically.

IMBA-> Help E |

The biokinetic model for intake regime 1 haz not been specified. ou need to zpecify this by going to the main zcreen and hitting
the 'Biokinetics' buttan [under model parameters, bottom right]

Do pou want bo do thiz now’?

Figure 5.19. Warning Notice to select a Biokinetic Model for the Indicator Nuclide.
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5 ™" Note: For all Associated Radionuclides, |MBA Professional automatically
—— selects the currently recommended ICRP biokinetic model.

iy

The Progress Indicator (Figure 5.20) displays which part of the calculation is currently
being performed, and when the final dose calculations are complete. All calculations are
sequenced and performed automatically. In the example shown in Figure 5.20, IMBA
Professional is calculating the numbers of radioactive disintegrations in each source organ
resulting from the third intake (IR3) - for the Associated Radionuclides - the

second checked calculation.

| INTAKE | CALCULATION

IR 1 |2.E|E|EE+IZ|2 Bq

R2 [EaEas Ba Eal-::ulallunsl Wh ] WT ]
IR3 [11esE+0z B

— Select
[1] Doze fram Indicator Muclide: Pu-238 ™
[£] Doze from Agszociated R adionuclides v
2] aze i each Ealendarn T ear r

Effective Doze [Sv]

LCalculate Ii

— Progresz Indicatar Dt
(1] AEEREENENEENEEENNEERNNEEENNEEENEEER
(2] EENENEEEENENENEN NN ENNENENENEENENEEEEN]
(3 |

Current - — -

Operation Calculating Disintegrations {IR 3)

Figure 5.20. Progress Indicator shows what calculation is currently being performed.

Dose Results Windows 00
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Figure 5.21. Displayed results of a completed Dose Calculation set to show Equivalent

Doses in the "Dose" windows.

Figure 5.21 shows the results for Equivalent Dose displayed in two windows:

e Indicator Radionuclide window - for each separate Intake Regime (IR), together
with the Total Equivalent Dose from all intake regimes to each Target Organ;

e Associated Radionuclide window - for each Associated Radionuclide, together with
the Total Equivalent Dose from all associated radionuclides to each Target Organ.

You can toggle the "Equiv/Eff" selector for either window to switch the display instantly
between Equivalent Dose and Effective Dose. Figure 5.22 shows both window displays

switched to Effective Dose.
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Figure 5.22. Displayed results of a completed Dose Calculation set to show Effective
Doses in the "Dose" windows.
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Note: During a calculation, the dialog box labeled " Effective Dose (Sv)" in
Figure 5.21 displays first the Effective Dose calculated for the Indicator
Nuclide - as soon as this result is available. Once the calculations are
completed for the Associated Radionuclide(s), the total Effective Dose from
the latter is automatically added to that from the Indicator Nuclide, and the
result (overall total) is displayed in the dialog box._
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Example Dose Calculation

; == Note: This example illustrates the calculation of doses for the multiple

il

A
—— intakes case (Miller et al., 1999) described earlier.

Clicking the "Dose Calculations" button in the Main Screen, opens the Dose
Calculations screen (Figure 5.23). The Indicator Nuclide defined in the Main Screen is
automatically shown in the "Dose from indicator radionuclide" /abel - under the
"Calculations" tab in this example "Pu-238." Also, the previously estimated amounts of
each intake (in this example IR1, IR2 and IR3) are also displayed automatically under
"INTAKE."

E%. Doze Calculations

File Toolz Advanced Help

E u_ | Dose Calculati
INTAKE | CALCULATION

IR 1 |2.E|E|EE+IZ|2 Bq

Calculations iR T
IR 2 |1.534E+IZ|2 Bq I ] ]
IR 3 |1.1EEIE+IZ|2 Bg

— Select
[1] Doze from Indicator Muclide: Pu-238 v
[£] Doze from Agzociated R adionuclides r
2] aze i each Ealendarn T ear r

Effective Doze [Sv]

LCalculate | Ii

Figure 5.23. Checking the "Dose from indicator radionuclide (Pu-238)" dialog box in
the Dose Calculations screen.

BEFORE calculating any doses, you need to select the values of Radiation Weighting
Factor (wg) to be used. This is done by clicking the "WR" tab in the "CALCULATION" sub-

panel. If the values of w, have NOT already been specified, the "WR" tab will appear as in
Figure 5.24.
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CALCULATION
_|>g
Calculations WhH ‘ W ‘

Thiz option allows you to gpecify the radiation weighting factors
that will be uszed in the calculation of equivalent doze.

Alpha 1] ICRP Defaults

Beta ID— zer Defined

Clear

Gamma |p

Not Specified

Figure 5.24. "WR" tab before values of the radiation weighting factor have been defined.

Click the "ICRP Defaults" button, to load the ICRP-recommended (as also prescribed
by 10-CFR-835) values of wy:

CALCULATION
—
Calzulations WwhH ‘ W ‘

Thiz option allows you to zpecify the radiation weighting factors
that will be uzed in the calculation of equivalent doze.

Alpha  [2g
Beta I.I— zer Defined

Clear
Gamma [4

ICRFP Defaults

Figure 5.25. Loading the ICRP Default values of radiation weighting factor.

Click the "WT" tab to select (or confirm the previous selection of) the ICRP60/68 tissue
weighting factors (WT) - see Figure 5.26.
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CALCULATION
_|>g

Calculations ] Wh ] WwWT I

Thiz option allows you to gpecify the tizzue weighting factors
that will be uzed in the calculation of effective doze.

(Edit Tizzue ‘Weighting

ICRP 68

Figure 5.26. Selection of ICRP60/68 tissue weighting factors.

Click the "Edit Tissue Weighting

Factors" button to select and/or confirm the ICRP60/68 values of tissue weighting factors
and the remainder tissue rules (Figure 5.27). Click the "OK" button to return to the Dose
Calculations screen.
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ﬂ!‘} Tizzue Weighting Factors
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{1 Slaays apply epliting le b I_
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*Dvaries I r LMHIET] I r £ W W T apmlh e splititg e
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*Testes I r BBbas I r
Thyroid 0.05 r bb I r
R.B.M. 01z r A I r
Bone Surface oo r LM[TH] I r
Stomach 01z r Esophagus 0ns r
5.1 I = * Gonads ||:|_2 r ICRP 68
L. I r Spare I r oK
L.LI I r Remainder 0ns —
* [aonads dose is the higher of Testez and Ovaries dozes | + Colon doze iz the mazs weighted average of L
Figure 5.27. Selection of ICRP60/68 values for the tissue weighting factors
and ICRP60/68 remainder tissue rules.
Calculation of Equivalent Doses 00

To calculate the equivalent doses received by all target tissues (from each of the 3
intakes):

e click the "Calculations" tab;
e click the "Calculate" button.

The calculated doses will be displayed in the "DOSE" table for the Indicator

Radionuclide (Figure 5.28). Use the scroll bar (right-side) to view the equivalent
doses calculated for the additional Target Organs.
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Figure 5.28. Calculated values of Equivalent Dose (for the Indicator Radionuclide).

Display of Effective Doses 00

IMBA Professional Plus calculates (and stores) ALL doses of interest (including the effective
dose resulting from each intake) in one step. Therefore, it is not necessary to carry out a
further calculation to display the effective doses. Simply click the

"Eff" option to switch the display to Effective Dose (Figure 5.29).
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Figare 5.29. Displaying the TOTAL Effective Dose resulting from each intake (and the
contributions from each target organ).

The values of Effective Dose that are calculated to result from each separate intake (in
the multiple intakes example case) are:

e EIR1 =17.9 mSv (1.8 rem);
e EIR2 = 9.2 mSv (0.9 rem);
e EIR3 = 7.0 mSv (0.7 rem).

The TOTAL Effective Dose (from all Intakes) is calculated to be 34.1 mSv (3.4 rem).

Tip: Itis instructive to repeat the above calculation for the "initial" and each
subsequent estimate of the intake amounts (see Optimizing the Intake Estimation ),
V- together with their respective assumed Model Parameters. This will indicate
the range of uncertainty in the calculated Effective Dose that results solely
from the intake estimation process. Try this for yourself - it is quick and
easy! Uncertainties in the biokinetic models (and dose-weighting factors) will,
of course, contribute additional uncertainty to the Effective Dose.

: Tip: Also try repeating the example dose calculation after selecting 10 CFR
w 835 tissue weighting factors and remainder tissue rules.

Calculating Doses from Associated 00
Radionuclides (Using Add-On 3)

Doses from Assaciated Radionuclides are calculated at the same time as those from

the Indicator Nuclide - see Dose Results Windows. In fact, setting up the dose calculation
for Associated Radionuclides is even simpler than setting up the Indicator
Radionuclide dose calculation:
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1. Select each Associated Radionuclide - from the Periodic Table of the
Elements (in the Main Screen).

2. Define the Abundance (in %) of each Associated Radionuclide relative to
the activity of the Indicator Nuclide - this is assumed to be the same for all
Intake Regimes.

3. Check the "Dose from Associated Radionuclides" box in the
"Calculations" sub-panel (Dose Calculations screen).

4. Click the "Calculate" button.

IMBA Professional Plus will automatically load the recommended ICRP Biokinetic Model for
each Associated Radionuclide (to calculate the number of disintegrations in each Source
Organ) and then use the recommended ICRP SEE Data File to calculate the resulting doses
to Target Organs. See also the Technical Basis section on Treatment of Associated
Radionuclides.
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